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Support
The  purpose  of  the  given  description,  at  first,  to  give  initial  representation  about 
working methods with Pradis32, and secondly, to ensure the user in exhaustive volume 
of help information.
Chapter  — some kind of introductory holding with Pradis32 in which all sequence of 
acts from creation of model before scanning and editing of outcomes is given.
Chapter   gives  the enumeration and the description of  all  types of  files  which user 
Pradis32 will meet in the course of operation.
In chapters   and   the attention is directed to extremely important possibilities of the 
program:  functionality  of  a  COM-server  and  a  possibility  of  operation  with  great 
volumes of data.
Chapter  — a short reference administration on commands Pradis32.

1. Instance of operation with Pradis32
1.1.Design creation

After start  of  program Pradis32 by the first  step there should be a  discovery of the 
existing design or creation new. The Pradis-project is under construction on the basis of 
existing VAR and TRN-files from which it gains all initial informations about model 
structure. By means of Pradis32 it is possible to broadcast the text description of model 
in language PradiSLang in VAR and TRN-files. For creation of the new design follows:

1. To choose in the principal menu 
point  FileNew (to  take 
advantage of the button on  a 
board  of  instruments  or 
accelerator  Ctrl+N).  Dialogue 
New Document As a result will 
open,  offering  to  choose,  what 
type of the deed is  required to 
create ().

2. Now Pradis32 can create deeds 
of four types (item  see):

a. Pradis32  Document — 
the  deed  for 
representation  of 
outcomes  of  calculations 
in the form of graphs.

b. Pradis32 Template — the deed mask, allowing to save customisations 
of representation of graphs and to use them at creation of new deeds.
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c. Pradis32 Project — the model Design. 
d. PME Document — the Deed of the editor of models.

Text window Use Document Template present at dialogue sets a mask matching to the 
created deed. At creation of the new design it is possible to leave the name offered by 
default: the mask is required only at a stage of representation of outcomes. Besides, it 
can be replaced at any moment already for the existing deed. As our purpose — creation 
of the new design it is necessary to choose type of deed Pradis32 Project and to push 
OK.

Creation of the new Pradis-design demands the job of additional customisations. After 
closing of dialogue  New Document there is dialogue  Project Setup, allowing to link 
with the new design all necessary files and catalogues. In it are set:

e. Name of the new design (Project Name).
f. The catalogue, in which it should be placed (Location) (is admissible the 

job of the nonexistent catalogue: if necessary it will be created).
g. Model name (Model). This name of a VAR-file which will be used in the 

design. It is supposed, that near to a VAR-file file TRN matching to it 
lays.

If at the moment of creation of the design the computational model exists only in the 
form of the text in language PradiSLang, it is possible to take advantage of the button 
“Create model from PRADISLang script” for text translation in files VAR and TRN. 
After pressure the button there will be a dialogue “Translate”.
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3. In dialogue it is necessary to choose a path to an input file (PradiSLang file). 
For path sampling to output files (“Output VAR file”) it  is possible to take 
advantage of button "Default" opposite to a matching field. Thus the path to an 
output file will be installed as a path to input + “.VAR”. After sampling of 
paths  for  a  translation  ringing  it  is  required  to  push  the  button  “Start 
translation”. At successful translation the icon “Status” will look as in drawing 

above.  If  translation  has  not  passed,  it  is  necessary  to  edit  initial  text 
PradiSLang  for  purification  proceeding  from  a  contained  leading-out 
(“Translation output”) and to iterate a ringing “Start translation”.

4.  For text editing it is possible to take advantage of button "Edit" to the right of a 
field “PradiSLang file”. Thus the model text will be opened in the text editor 
installed in the field “Input File Editor”. If the field is empty – it will be offered 
to choose the program for editing. In the field Input File Editor ”it is possible to 
instal the editor of text files by default, having pushed on button" Default "to 
the right of a field. After end of editing the file in the editor should be saved, 
not changing his name.

5. After  successful  translation  of  model  it  is  necessary  to  enclose  dialogue 
“Translate” on “OK”. Thus in the field “Model” dialogue  Project Setup the 
path to VAR to a file created in dialogue “Translate” will automatically hit.
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For creation of  the  new design in  dialogue  Project  Setup it  is  necessary to 
specify  all  demanded  paths:  while  though  one  field  empty,  button  OK  is 
inaccessible.
By pressure on OK Pradis32 creates, if it is necessary, catalogue Location. In 
catalogue Location take places, at first, a file of the new design, secondly, the 
catalogue of outcomes with the same name. In the catalogue of outcomes model 
files (VAR and TRN) are patterned. On it process of creation of the design is 
completed.

1.2.Preparation of the design for the solution

After successful creation of the design in a window at the left there is a line with a name 
of the design which on double click of the mouse is uncovered in a model tree (). This 
tree  is  initial  contains  two  nodes:  a  gang  of  parametres  Volatile  Parameters  and 
customisations  of  procedure  of  solution  Solver  Settings.  Node  Volatile  Parameters 
contains  one  поддерево Variant  in  which  all  are 
enumerated  accessible  in  the  given  model  changeable 
parametres.  Basically  the  model  is  ready  at  once  for 
calculation execution. As it contains only those data that it 
was possible to read from a VAR-file in it one alternative 
of  calculation  defined  by  a  current  gang  of  changeable 
parametres  contains  only.  Singularity  Pradis32  is  the 
possibility  of  the  automized  execution  of  multivariate 
calculation. For this purpose it is required to add demanded 
alternatives  in  the  design.  It  is  provided  two  modes  of 
adding of new alternatives: creation of new node Variant 
and adding of alternative of changeable parametre.

1.2.1.Adding of alternative of changeable 
parametre

For  alternative  adding  it  is  necessary  to  choose  the 
demanded  parametre,  let  it  will  be  the  Gravity,  and  to 
make active its double click of the mouse or Enter th. To 
the right of a model tree there will be a window with the 
table of parametre values. The table always contains in just 
created design one line: from a VAR-file one alternative 
arrives only. The table as follows is edited:

1. Modification of values of a mesh. 
a. Gate  out  a  demanded  mesh  and  push  a 

white  space.  The  mesh  will  go  into  an 
editing.  The  same  effect  can  achieve  if 
doubly to click on a mesh the mouse.

b. Inject new value.
c. For acknowledging of injected value push 

Enter:  the  mesh  will  get  out  an  editing, 
having remembered new value. For cancelling of feeding into instead of 
Enter it  is  necessary to push Esc:  the 
mesh  will  get  out  an  editing,  having 
rebuilt a reference value.

2. Adding of a line.
For adding of a line simply push Insert: the new line 
will be put in before current line (containing the gated 
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out mesh). For adding of a line in the extremity it is necessary to gate out a mesh last, 
not used line.

3. Removal of a line. 
For removal of a line choose in the menu command EditClear, the button on a board 
of instruments or simply push Delete: the current line will be deleted.
Note 1. If the table contains only one alternative, that is only one line with values this 
line cannot be deleted. The closing empty line also cannot be deleted.
Note 2. The number of measurements in each parametre is defined from a VAR-file and 
further cannot be changed. Therefore adding of columns in the table is not provided.
So,  we  will  add  new  alternative  in  parametre  the 
Gravity. The table for this parametre will look as, for 
example,  on  5.  Now to parametre  the Gravity there 
match  two  values,  and  the  design  contains  two 
alternatives  of  calculation.  Analogous  operation  we 
will execute for parametre  the Point About ().  Now 
the  design  contains  4  alternatives  of  calculation.  At 
adding  of  new  values  of  changeable  parametres  the 
assemblage of alternatives of calculation is product of 
ranges of parametres. Such mode of customisation of 
multivariate  calculation,  is  convenient,  apparently, 
when it is necessary to vary value of one or several parametres and for each alternative 
to gain the solution. When it is required to count a little basic various alternatives, more 
preferable there is a duplicating in model of node Variant.

1.2.2.Adding of a new gang of parametres (Duplicating of node 
Variant)

It is necessary for duplicating of node Variant 
1.To gate out node Variant in a model tree.
2.To call from the principal or context-sensitive menu command Duplicate Node or 

to take advantage of accelerator Alt+Insert.
As a result in a tree there will be second node Variant. A gang of parametres and their 
value precisely same, as in an initial node: a new node — its exact duplicate. 
As  now the  tree  contains  two nodes  Variant in  order  to  avoid  confusion  the  new 
alternative is desirable for renaming. For this purpose it 
is necessary

1. To gate out a demanded node.
2. To click on it repeatedly the mouse or to call 

point  of  menu  Rename  Node (procedure  is 
analogous to renaming, for example,  a file in 
Windows Explorer).

3. To  set  a  new  name  of  a  node,  for  example, 
Another Variant.

As a result the tree of model will become, as is shown in 
. In model two independent assemblage of alternatives 
of  calculation  was  organised:  Variant and  Another 
Variant. In both alternatives of the table of parametres can be edited separately as it has 
been displayed in item . In the present model if node Variant has been converted, as to 
item , contains 4+4=8 calculation alternatives, and these two gangs are identical.
Let's assume, that it is necessary for us, except a gang of the calculations set in Variant, 
to make scalings and for an initial gang of parametres, that has been read from a VAR-
file.  However both alternatives  Variant and  Another Variant are contained by the 
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changed data. For sweeping deriving of initial data it is the most convenient to make the 
following:

1. To gate out demanded alternative, for example, Another Variant
2. To call from the menu command EditReset Content (Ctrl+D).

If  now to open tables of parametres  the Gravity and  the Point About in  Another 
Variant instead of tables on  initial tables of parametres  . At the command of  Reset 
Content all structure of parametres and their value have been anew rebuilt from model. 
We will note, that command Reset Content can be applied to any of nodes of a tree of 
model  (except  nodes  of  outcomes which while  in  a  tree generally  are  not  present). 
About its behaviour in each concrete case it will be told later.

1.3.The problem solution

So, the model is generated and contains 5 alternatives of calculation (4 in Variant and 1 
in Another Variant). The problem solution is started by command RunNew, thus all 
alternatives  sequentially  pay  off.  In  menu  Run  point  Sequential  —  calculation 
prolongation contains also, but in our case it  is inaccessible: the problem still  never 
dared.
At calculation start appear, at first, dialogue Solution Progress indicating, what share of 
a problem already decided and allowing to discontinue the solution, secondly, a window 
with process animation. Solution process can be retarded with the help слайдера in the 
lower part of a window animations (). 
The window of animation in the course of the solution can be enclosed: the solution will 
proceed without animation. At any moment the window can be rebuilt c the help of 

command View Animate. Visualisation will begin with a current stage of the solution 
(Animate it is accessible only in the course of the solution).
After calculation end in the catalogue of an output information there are 5 rsl-files, each 
of which contains outcomes of scalings for one alternative.
In a model tree there was new node Results with outcomes of calculation and now it is 
possible to pass to their representation.

1.4.Representation of outcomes

1.4.1.Sampling of alternatives of calculation for representation
Process of sampling of alternatives is extremely simple: it is necessary to mark with 
ticks interesting nodes in a model tree. And the status 
modification  поддерева leads  to  an  automatic 
modification of the status of its branches.
Let  it  is  necessary  to  represent  the  alternative 
matching  to  the  first  parametre  value  the  Gravity 
and  second  —  the  Point  About in  поддереве 
Variant.  Having  gated  out  an  interesting  node,  we 
will gain a picture . Now in the menu command Run
Show Diagrams (if, of course, the focal point is 
installed on a model tree) is accessible.
Note In  this  point  we  have  gated  out  only  one 
alternative of calculation. When it is required to gate 
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out some alternatives, figured on can appear inconvenient. For example, selection of all 
alternatives  for  a  parametre  value  the  Gravity  [1]  demands  only  one  act,  and  for 
analogous  operation  with  the  Point  About  [1]  them  it  is  required  already  two. 
Complexities  will  essentially  increase  at  magnification  of  number  of  parametres  or 
parametre alternatives. For simplification of selection of alternatives command Change 
Order is provided, allowing to change a sequence of parametres in a tree of outcomes 
(see ).

1.4.2.Creation of glow irises
Command Show Diagrams calls import dialogue (Import Settings), allowing:

1. To see a gang of the curves containing in chosen files. 
2. To choose, what of them should be displayed.
3. To arrange the chosen curves under glow irises.

Dialogue  Import  Settings consists  of  three  backfillings,  Placement,  Template  and 
Variants. On backfilling Placement three lists are had:

1. The list of input curves (Input Channels). In it the curves containing in an 
open file (ah) are enumerated. The list has three regimes of representation, the 
regime is set in combo box Show Channels.

2. The list of glow irises (Existing Diagrams). These are glow irises which will 
be created by pressure on OK.

3. The list of curves in the current glow iris (Active Diagram). It is the list of 
curves in the gated out glow iris (that on which there is a cursor in list Existing 
Diagrams).

The  detailed  explanation  of  possibilities  of  dialogue  Import  Settings and  working 
methods with it is beyond the first acquaintance with Pradis32 (item  more in detail see 
and ), therefore we will be restricted to most simple case: we will display all outcomes 
as offers  dialogue  Import Settings.  By default  he suggests to display all  curves on 
separate glow irises that is visible from list Existing Diagrams: it contains 12 entries. 
Now it is possible to push on OK and to get down to machining of outcomes.

1.4.3.Ringing 3D visualisation
Except two-dimensional graphs of output variables, pradis32 during calculation saves 
the information allowing by means of a player to scan 3D of a scene of behaviour of 
model at calculation. For a ringing of a player and show of a scene after the calculation 
termination it is necessary:
- To gate out left кликом mice (not simply to mark with a tick!) in поддереве outcomes 
Project Bar one of the lower nodes, that is one alternative of multivariate calculation 
for show. In the menu becomes active  View-> Run Visualizer (if, the focal point is 
installed on a model tree);
- To call the menu View-> Run Visualizer.  The player Thus should open and load a 
matching scene.

1.5.Acquaintance with Pradis32 Document

As it was spoken in item , Pradis32 supports deeds of 3 types: the design, the deed and a 
mask. At closing of dialogue Import Settings has been created Pradis32 the deed serving 
for  representation  of  glow irises  and  submitting  wide  sampling  of  means  for  their 
editing. 
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1.5.1.Operations with deed pages

1.5.1.1.Paging of pages
The gained deed is dissected into pages and the first is initially visible only. On a board 
of instruments the button is at the moment active,  by pressure on which the program 
displays the following page. In total in their deed it was gained 6. At passage to the 
following page there is active a button,  allowing to return on the previous. The same 
effect can achieve by means of keys Page Up and Page Down.

1.5.1.2.Modification of a format of page
At  the  moment  in  the  menu  command  EditSwitch  Page  Format  is  accessible, 
allowing to change a format of page with book on альбомный and is inverse. For this 
operation accelerator Ctrl+W is provided.

1.5.1.3.Representation change of scale
Initially at creation the deed is displayed in scale 100 % that can appear not always 
convenient.  In  the  menu  command  ViewZoom  with  which  help  dialogue  of 
customisation of a  scale of representation Zoom is  called is  provided.  Except the 
predetermined scales the user can inject own value over the range 5–2000 %. 
Regime Box Zoom which is switching on by means of command ViewMouse Mode
Box Zoom or the button on a board of instruments in which the user can gate out 
with the mouse an arbitrary rectangle on sheet is besides provided  and the page 
scale will vary so that this rectangle has appeared inscribed in an active window. Double 
click of the mouse in this regime leads to restoration of a scale of 100 %. Cutting off of 
regime Box Zoom: sampling in menu ViewMouse Mode of other regime (is better — 
Select) or pressure of buttons ( Select) or ( Scale).

1.5.2.Editing of installations
All  glow  irises  on  page,  and  also  its 
constituents,  can  be  gated  out  and  their 
properties can be changed. For selection of 
installations it is necessary to click on them 
the mouse.  It  is  possible  to gate  out  some 
installations  if  thus  to  keep  pushed  Shift. 
Over  the  gated  out  installations  operations 
(the  set  of  operations  is  defined  by 
installation type) are possible:

1. Copying Cut/Copy/Paste
2. Removal  without  copying  in 

Clipboard  and  restoration 
possibilities (Clear)

3. Editing of properties.
The  glow  iris  consists  of  following 
installations (). Certainly, customisations of 
the curve and all glow iris bodily also can be 
changed, is simple in drawing they are not 
signed.
In the capacity of the elementary exercise it is possible to change a hum noise of the 
first glow iris. For this purpose click the mouse on Plotting Area in the first glow iris on 
the first page doubly.
On  the  shield  there  was  dialogue  Diagram  Space 
Properties. Choose backfilling Appearance and instal 
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any other  colour  by  means  of  button  Set  Color  in  group Background,  or  generally 
remove a hum noise, having installed flag No Background Color. After pressure on OK 
the glow iris will change colour of a hum noise to the chosen.
Let's assume, that editing of glow irises on it is completed. The created deed with glow 
irises should be saved. For this purpose it is possible to take advantage of commands 
FileSave (Save As). Both of them will give equal effect — will display dialogue Save 
As as the deed is saved for the first time. Save the deed under a name, for example doc1 
(it is required to us further). 

1.6.Change and mask renewal

Let's create on the basis of just saved deed a mask. Mask use allows to adjust once 
parametres of the deed and then on its sample to create the new.

1.6.1.Mask change
While we possess only one mask — default.pdt (item   see).  On its fundamentals the 
deed also has been created. 

1. Not enclosing just created deed, choose command FileNew and open already 
known dialogue New Document (item  see). 

2. Choose type of deed Pradis32 Template and push OK. The new deed-mask 
forms  at  once;  creation  of  a  new mask  — most  simple  operation  in  New 
Document.

3. Choose  FileSave.  The  program will  display  dialogue  Save As.  Also will 
suggest  to  save  a  mask  in  some  catalogue  DocTemplates.  That  for  the 
catalogue, it is possible to learn it in item . To change the catalogue it is not 
recommended: masks should be saved in DocTemplates. Set a name of a new 
mask, for example, template1, push OK.

4. Enclose just created mask.
5. For the source document doc1 call point of menu FileChange Template. In 

the opened dialogue two files are visible: default.pdt and template1.pdt. Choose 
template1.pdt and push OK. 

6. Now at the deed doc1 a mask is template1. It,  generally speaking, does not 
influence the deed in any way: the mask is necessary at import. Besides, both 
masks default and template1 — empty. However mask change allows to update 
sweepingly  contents  template1.  Call  from  the  menu  command  Overwrite 
Template. It  has not led to any exterior modifications, however all contents 
doc1 have been copied in template1. Thus, on the fundamentals doc1 the mask 
template1, being its exact duplicate has been created.

1.7.And again representation of outcomes

Let's return now to point . 
1. Choose any other alternative of calculation, for example, Another Variant and 

execute all acts from item . 
2. When there will be dialogue Import Settings, pass to backfilling Template and 

push button Browse. 
3. In the appeared dialogue choose besides template1 and push OK. Creation of 

glow irises will happen the same as and for doc1, but the new mask will be 
used.

4. Push OK in dialogue Import Settings. There was a deed with data from other 
alternative of calculation, but its graphical customisations are identical doc1.

Use of masks sometimes can essentially save a time on formatting of glow irises.
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1.8.Representation of outcomes of several alternatives of 
calculation

In subitem  and  we represented outcomes of unit 
alternative  of  calculation.  Pradis32  submitives 
possibilities  for  simultaneous  representation  of 
outcomes of several alternatives. 

1. Return to item  and mark with a tick node 
Variant bodily.  Now the  program will 
represent outcomes of scalings from all 
поддерева Variant. 

2. Call dialogue Import Settings by means 
of command Show Diagrams (item  sm).

3. The  content  of  backfillings  Placement 
and Template has not varied: it common 
for  all  alternatives  (all  alternatives  of 
calculations  of  one  model  in  Pradis32 
contain  an  equal  gang  of  curves).  On 
backfilling Template again instal a mask 
default.pdt.

4. Pass to backfilling Variants.
5. In  list  Parameter  Set choose  a  gang of  parametres  Variant.  The  list  will 

contain on the right parametres of this gang (the Gravity and the Point).
6. Instal a tick in column Is Running for both parametres.
7. Be  convinced  of  that  flag  Place  every  variant  into  separate  page  (s) is 

installed. 
8. Push OK.

Creation of the deed with glow irises will be outcome of these acts. The amount and a 
disposition of glow irises in it is completely analogous to that has been gained in the 
deed saved earlier doc1. However now in each glow iris are collected on 4 curves from 
all alternatives. 
It is one of possible scenarios of representation of multivariate calculation. For detailed 
acquaintance to the included possibilities it is necessary to address to the description of 
commands Import (item ), Show Diagrams (item ) and Change Order (item ).
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2. Types of files Pradis32

Table 1. Types of files with which works Pradis32
Expansion The short description
ppj Design Pradis32

pd The deed for representation of glow irises

pdt Deed mask

pme The deed of the editor of models (it is presented in a separate administration)

rsx The information on outcomes of multivariate calculation

rsl File with outcomes of calculation

sci File with import customisations

var, trn Initial files of model

pgo Graphic information about behaviour of model at calculation

2.1.Types of deeds

2.1.1.Design Pradis32
The given type of the deed is used for computational model creation. Creation of such 
deed explicitly is presented in item . Files VAR are necessary For design creation and 
TRN which are patterned in the catalogue of a leading-out matching to the design. In the 
present version the leading-out catalogue forms in the same place where also the file of 
the design and has the same name, as the design and expansion output.  The design 
remembers a relative path to the leading-out catalogue so the design together with this 
catalogue can be patterned easily. After calculation in the leading-out catalogue there is 
a gang of RSL-files with outcomes of calculations and the RSX-file with the same name 
with the design. If at calculation the graphic information leading-out (see , subparagraph 
) with everyone RSL the file with the same name with expansion PGO will form by a 
file at calculation, a containing graphical leading-out of behaviour of model has been 
installed.  Files of designs have expansion ppj. For representation of structure of the 
design in the form of a tree special window Project Bar is provided. Simultaneously one 
design can be opened only. At creation or discovery of the new design the program will 
suggest to enclose the current design beforehand.

2.1.2.The deed
Pradis32  Supports  also  special  type  of  the  deed  for  representation  of  outcomes  of 
calculation in the form of glow irises. Such deed can be created, at first, explicitly, at the 
command of menu FileNew, secondly, at representation of outcomes of calculation as 
it is presented in . If the new deed is created by means of command New glow irises in it 
can be added, at first, by copying (Cut/Copy/Paste or Drag&Drop) from other deed, 
secondly, by means of import from a RSL-file (item  see). In the latter case at creation 
of  new glow irises the mask — special  variety  of the deed for  saving of  graphical 
customisations is used.
 The major singularity of the pd-deed — a support for it an embedding possibility (item 
see).
Files of deeds Pradis32 have expansion pd.
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2.1.3.Deed mask
As,  for  example,  in  Word,  any  pd-deed  in  Pradis32  is  grounded  on  a  mask.  The 
information from a mask is used at creation of the deed and at import. Per se a mask — 
the usual deed admitting all those operations that are allowed for the pd-deed, but:

1. It  has  no  mask.  Therefore  commands  Change  Template  and  Overwrite 
Template (item 5 see) for it are inapplicable.

2. For  saving  of  masks  Pradis32  creates  special  subdirectory 
ctm_mod/Pradis32/DocTemplates  in  the  system  catalogue  of  current  user 
Application Data (it is set by a variable of environment APPDATA).

For defined notion masks:
1. Application template by default default.pdt. It is analogue Normal.dot in Word. 

If  the  application  does  not  discover  it  in  the  standard  catalogue  of  masks 
(%APPDATA %/ctm_mod/Pradis32/DocTemplates), it forms anew.

2. Current mask. On the basis of a current mask there are new deeds. The name of 
a current mask can be seen at discovery of dialogue New Document. The Same 
dialogue allows to replace a current mask.

3. Deed mask. The given mask is used at import and adding of pages to the deed. 
At deed creation in the capacity of a deed mask the current mask is installed. 
Change of a mask for already existing deed is possible by means of a command 
of menu FileChange Template.

Program response in cases when it is impossible to discover or open a mask is defined:
1. It  is  impossible  to  open  a  mask  by  default  (default.pdt).  In  this  case  the 

application simply oscillates it anew. It refers to as to a case when the mask file 
is not discovered, and to a situation when the file is recorded in an incorrect 
format.  In the second case the file is transcribed. The program also tries to 
create the standard catalogue of masks if it is absent. In case of failure by the 
standard catalogue the catalogue in which is pradis32.exe appears. Mask Stock-
taking default.pdt is made at each start of the program.

2. It is impossible to open a current mask. At start and at the moment of a ringing 
of dialogue New Document the program musters presence and correctness of a 
format of a current mask and in case of an error instal in the capacity of leaking 
a mask by default. If the user has chosen a mask with an incorrect format by 
pressure on OK the diagnostic message for an error and dialogue will be given 
out will not be enclosed.

3. It is impossible to open a deed mask. Check of a format of a mask of the deed 
is  made  directly  ahead  of  execution  of  the  operation,  demanding  a  mask 
(import and adding of pages). In case of an error the user is offered to assign 
other mask. Files of masks have expansion pdt.

2.2.File of control of outcomes of calculation

Simultaneously with creation of a file of the design in the leading-out catalogue there is 
a file of control by outcomes with expansion RSX. In it all data necessary for show of 
graphs  from  RSL-files  of  last  multivariate  calculation  (names  and  number  of 
alternatives of changeable parametres) and current customisations of import of data are 
saved. By means of data from this file the program discovers all rsl-files belonging to 
the current design.
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2.3.Files of data

In  the capacity  of  files  of  data  rsl-files  Pradis  are  used.  A format  singularity  (it  is 
necessary to tell — an unpleasant singularity) is necessity to use a matching VAR-file at 
data reading. Pradis32 can open rsl-files, if 

1. Nearby the VAR-file with the same name lays. It is traditional for old Pradis 
the circuit design of operation which is supported for compatibility. Such mode 
of generation of rsl-files in Pradis32 is unacceptable, as cannot combine with 
multivariate calculation when near to one VAR-file the whole set of files rsl 
should place.

2. Near to a rsl-file the VAR-file which name can be gained transformation of a 
name of a file rsl lays. At the solution of problem Pradis32 oscillates a gang of 
the rsl-files which names are organised by a rule:

(A design name) # (a VAR-file Name) # (identifier).rsl
From such name Pradis32 takes a name of a VAR-file and has an opportunity to read a 
file rsl. It is clear, that old visualisation tools of calculations Pradis immediately cannot 
read such file.
Data from files rsl can be represented in pd-deeds (or in pdt).  For this purpose it is 
necessary or to start procedure of representation of outcomes of calculation (item  see), 
or to execute import from a rsl-file (item  see). In the second case not necessarily that 
the file rsl belonged to any design Pradis32, the main thing that near to it the matching 
VAR-file (link of names of files was can be both 1st, and 2nd aspect).

2.4.Import scenarios

Optional files with expansion sci are used for saving of a condition of dialogue Import 
Settings (item  see) and its sweeping loading at the subsequent sessions of import.

2.5.Initial files of model

Initial files of model VAR and TRN are necessary for normal operation Pradis32 of the 
design and are put to it in correspondence immediately at creation. For Pradis32 these 
files — an input information and it never edits them.

2.6.Files with a graphic information.

These  files  form at  calculation  together  with files  of  data  ().  They have  the names 
coinciding with names RSL of files (files RSL with the same name and PGO match to 
calculation with an equal gang of parametres) and expansion PGO. These files contain 
in a  text  format  (simplified XML) the information on visual  behaviour  of  model at 
calculation. Files are supposed to be opened after calculation by a player, for scanning 
3D scenes of behaviour of model at calculation.

3. Possibilities Pradis32 as COM-server
The developed application is full-server th OLE, i.e. can be started both as the separate 
application and as  the  editor  of  firmware Pradis32-installation.  The deed with glow 
irises, that is the pd-document can be firmware.  — an instance of such deed. If at you it 
is already installed Pradis32 it can be opened and edited.
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 Operation with firmware installation is possible in two regimes: in-place editing and 
editing in a separate window. The first regime, apparently, is most convenient at editing 
of the firmware deed with a variable format of page, especially if the deed consists of 
one-two  glow  irises.  In  MS  Word  installation  discovery  in-place  is  executed  by 
command EditObjectEdit. In the second regime appearance of the user interface is 
as much as possible approached to stand alone to a regime (discovery of the independent 
deed) and it is represented convenient for editing of the big installations, in particular, 
firmware deeds with the fixed format of page. In MS Word installation discovery in a 
separate window is executed by command EditObjectOpen.
To build in Pradis32-installation in OLE the container it is possible:
-Having copied data from the deed through clipboard (cut/copy/paste or drag&drop);
By means of command Insert Object in the application-container (in Word it Insert
Insert Object). The title of demanded deed Pradis32 Document.

4. Additional means for operation with great 
volumes of data

Pradis32  Allows  to  represent  curves,  to  which  match  big  enough  (theoretically  — 
unlimited) volumes of data. For this purpose in it are provided:

1. Possibility of use of the linked data.
2. Thinning out of data before drawing.

4.1.Curves with the linked data

At import curve data are usually patterned in the deed and become its part. In this case 
the initial file of data after import is not necessary any more. However it can lead is 
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inadmissible to the big file sizes of the deed. In Pradis32 the mechanism with which 
help the deed is provided remembers only the reference to a file of data. In this case in 
the deed the relative path to a file of data is remembered, therefore they can be patterned 
together and to transfer on other computer: the deed will not lose working capacity. The 
mode of embedding of data in the deed is defined at import (item  see), the linked data if 
necessary can be built in the deed in further (item  see).
Note.  Operation  with the  linked data  is  admissible  only for  the  separate  deed.  The 
firmware deed always stores in itself all data (item  see).

4.2.Thinning out at copying

At drawing of curves the program uses not all points. Specially designed mechanism 
beforehand creates the thinned out sequence of points, sufficient for representation of a 
curve with demanded quality. Quality of thinning out can be adjusted from dialogue 
Customize (item  see).

5. The enumeration of commands of menu 
Pradis32
5.1.File

5.1.1.New, Open, Close, Save, Save As
These  standard  commands  for  a  Windows  application  realise  creation,  discovery, 
closing and saving of deeds.

5.1.2.Change Template
The command allows to replace the mask linked with the deed, and it is accessible only 
to the deed (pd) and the design (ppj). An accelerator — Ctrl+T.

5.1.3.Overwrite Template
This command allows to update contents of the mask linked with the deed (actually 
executes Save Copy As in a current mask of the deed). The command is accessible only 
to the deed (pd-file) (the mask has no mask, and it is necessary to the design (a ppj-file) 
only for creation of pd-deeds) and only in stand-alone a regime (the firmware deed 
though has a mask, but never it uses). An accelerator — Alt+S.

5.1.4.Import
This command is accessible to deeds and masks (pd and pdt-files) and realises import 
from an exterior file of data in the deed. At first the user is offered to choose a file of 
data from which import will be carried out. After file sampling dialogue Import Settings 
the representing list of channels containing in a file and allowing is called:

1. To define, what channels should be used at import.
2. To assign amount of glow irises and distribution of curves under glow irises.
3. To define a sequence of glow irises.
4. To define a sequence of curves in the glow iris.
5. To assign a mask of the deed which will be used at import.
6. To save the created scenario of import in a file of the scenario (.sci-file)
7. To execute import according to customisations in a sci-file.

Dialogue Import Settings is executed in the form of the list of properties (property sheet) 
and consists of two pages. 
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5.1.4.1.Page Template
Page Template allows

1. To choose a deed mask with which help import will be executed. This mask 
becomes leaking for the deed (if, of course, import is executed in the deed (a 
pd-file), instead of in a mask (pdt): the mask does not have mask)

2. To instal desirable number of glow irises on page. At installed flag Place as in 
Template the set numbers of lines and columns are used only as a last resort, 
for example, when the matching page of a mask at all does not contain glow 
irises. At the removed flag indicator of the glow iris are upbuilt how it is set by 
the user, the information on a disposition of glow irises in a mask is ignored.

5.1.4.2.Page Placement
On this page customisation of disposing of curves in glow irises is executed.  On page 
three lists are put: 

1. Input channels.
2. Existing glow irises.
3. Curves of the active glow iris.
4. The list of input channels has three regimes of representation:
5. All. All input channels are represented.
6. Unused. The channels which have been not switched on in one of existing glow 

irises are represented.
7. Suitable. It, at first, not used channels, secondly, suitable for an insertion in the 

active glow iris (have the same dimensions of a quantity of axes).
The glow iris which has been gated out in the list of glow irises is active. If it is not 
gated out any glow iris, or some glow irises are gated out, the active glow iris is not 
defined also the list of curves of the active glow iris is inaccessible. If for input channels 
regime Suitable in this case the list of input channels also will be empty is installed. By 
sight the list of input channels in regimes of representation All and Unused presence or 
lack of the active glow iris does not influence.
To lists of glow irises and curves of the active glow iris there match steams of buttons 
Up and Down. These buttons allow to change a sequence of glow irises and curves in 
the glow iris.
Flag Embed Data Into Document had in the bottom of dialogue defines, whether should 
given be built in in the deed (is installed) or it is necessary to create references to a file 
(is removed).
When it is not required to adjust manually disposing of each curve, it is possible to take 
advantage of the additional dialogue Standard Placement called by means of the button 
with the same name on page Placement. This dialogue is analogous to old dialogue of 
import and allows easier, than by means of the basic dialogue:

1. To gate out for each chosen curve the separate glow iris
2. To sort curves under glow irises according to dimensions of a quantity of axes.

5.1.4.3.Saving and scenario application
The current condition of customisations of dialogue Import Settings can be saved in a 
file of the scenario (sci-file) by means of button Save. In the subsequent the scenario can 
be loaded from a file by means of button Load. It can appear useful in a case when it is 
necessary to put in into the deed data from several files with an equal gang of curves: 
import can be adjusted once and in the subsequent to apply the saved scenario. 
Import is impossible in the firmware deed and the command is accessible only in stand-
alone a regime. An accelerator matching to a command — Ctrl+I.
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5.1.5.Metafile
Saves the image of current page in a metafile. The user is offered to choose a metafile 
name. To assign expansion to a file name not necessarily:  expansion matching to a 
chosen format in case of need will be automatically added. Metafile saving in formats 
emf and wmf is is possible.

5.1.6.Print, Print Preview, Print Setup
Printing  stereotyped  commands.  Now  the  current  page  is  typed  only.  For  printing 
альбомной pages it is necessary to instal a demanded format in menu Print Setup.

5.1.7.Translate PRADISLang
Calls dialogue “Translate” intended for translation of the description of a computational 
model in language PradiSLang in binary files of model.VAR and.TRN. This operation 
is necessary, as the design pradis32 can be created only on the basis of binary files. 
Dialogue “Translate” also can be called at design creation to create binary files from 
text PradiSLang, and then on their fundamentals to create the design. Here (in the menu) 
dialogue is called separately, on a case if it is necessary simply оттранслировать text 
PradiSLang in binary files, not creating from them the design.

5.1.7.1.Dialogue “Translate”.
Dialogue contains three blocks of customisations:
- External application
- Translation Settings
- Translation output
And also buttons “Start translation”, “OK”, “Cancel”.

External application
The block the foreign editor whom the input file from a field “PradiSLang file” will be 
opened,  presents  sections “Translation output”  by pressure button "Edit".  The Entry 
field “Input File Editor” contains a path to an executed file of the editor. By button 
"Browse" it is possible to choose a path on a disk. Button "Default" will instal in the 
field of feeding into a path to the editor associated in Windows with text files by default.

Translation Settings
The block presents translation customisations:
- The entry field “PradiSLang File” contains a path to the model text. Button "Browse" 
it is possible to discover a path on a disk. Button "Edit" creates a file from entry field in 
the foreign text editor for editing. The path to the editor is set in the block “External 
Application”. If it is not installed, by pressure on “Edit” the standard window Windows 
will be called, allowing to choose this editor from the program list.
-  The  entry  field  “Output  VAR  File”,  sets  a  path  to  output  files  to  outcomes  of 
translation. The path to VAR to a file is in the field set. File TRN will form in a course 
трансляциии near  to  VAR  by  a  file.  His  name  will  be  same,  as  at  VAR  a  file 
(expansion  differs).  Кногпка “Browse”  allows  to  choose  an  output  path  on  a  disk. 
Button "Default" will instal in the field of feeding into the same path, as in the field 
“PradiSLang File”, but with expansion adding “.VAR”.

Translation output
The block contains a leading-out of outcomes of translation. 
- The field “Translation output” represents a leading-out of modules pradis32, created 
during translation (a file sysprint.txt in the same directory, as output VAR a file). 
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- The icon “Status” displays, whether there has successfully passed last translation. - 

it is successful, - it is not successful.
- Wireless button "Encoding" allows to choose the coding in which it is necessary to 
perceive a file sysprint.txt at representation (Windows/DOS). 
- The button “Refresh sysprint.txt” allows to re-read sysprint.txt in the field “Translation 
output”.

OK/Cancel/Start translation
The button “Start translation” calls translation start. After its ringing, in case of success, 
there will be binary files of model. In any case it will be re-read sysprint.txt and the icon 
“Status” will be updated. OK and Cancel enclose dialogue “Translate”. In case of OK 
values of customisations of dialogue will be saved and displayed at a following ringing 
of dialogue.

5.2.$ RUN :

5.2.1.New
Starts new calculation of the design opened at the moment. If with model rsl-files with 
outcomes  of  the  previous  calculations  these  files  are  annihilated are  linked.  An 
accelerator — Ctrl+U. The button on a board of instruments— .

5.2.2.Sequential
Starts additional calculation for the design opened at the moment. Additional calculation 
is impossible if:

1. For the design new calculation (command RunNew was never called) was 
not carried out.

2. In  the  course  of  model  editing  there  was  a  modification  of  number  of 
alternatives of calculation.

3. It was called Reset Content for any node.
4. At  additional  calculation  new outcomes  are  added  in  existing  rsl-files.  An 

accelerator — Alt+U. The button on a board of instruments— .

5.2.3.Show Diagrams
Starts procedure of representation of the chosen gang of outcomes of calculations. Thus 
in memory there is a temporary pd-deed in which glow irises are drawn. This deed in 
the subsequent can be saved by means of FileSave.
Those alternatives of calculation which are marked by a tick in a design tree (Project 
Bar) are chosen.
At the command of Show Diagrams dialogue Import Settings (see  ) is called. In this 
case this dialogue contains additional backfilling Variants () and allows to adjust import 
at once from several files of data. 
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Sense of elements of backfillings Placement and Template to a similar case of import of 
an individual file  .  These customisations are applied to each observed alternative of 
calculation (the structure of outcomes in all alternatives is identical, differences only in 
numerical values). Show of glow irises of multivariate calculation for the user looks as 
consecutive  search  of  separate  alternatives  with  application  to  each  of  them  of 
customisations  from  backfillings  Placement  and  Template  with  the  subsequent 
rearrangement  of  the  gained  blocks  by  means  of  customisations  from  backfilling 
Variants.

5.2.3.1.Order of search of alternatives
 The order of search of alternatives also is set on backfilling Variants. For this purpose it 
is  necessary  to  choose  at  first  a  demanded  gang  of  changeable  parametres  in  list 
Parameter Set. In the list names of parametres from the chosen gang on the right are 
represented.  The  order  of  their  following  in  the  list  defines  an  order  of  search  of 
alternatives  of  calculation.  First  alternatives  of  last  parametre  in  the  list,  then 
penultimate etc. For example, customisations on   are run. Set the following order of 
search of alternatives: (the Gravity [1]; the Point About [1]) … (the Gravity [1]; the 
Point About [m]) … (the Gravity [n]; the Point About [1]) … (the Gravity [n]; the Point 
About [m]). The Sequence of parametres in the list can be changed by means of buttons 
and . 
Ticks in an extreme left column (Is Running) define, whether will match to parametre 
usual  ( )  or  a  "running" index ( ).  To both parametres on   there  match the usual 
indexes, therefore to each of enumerated above alternatives there matches the gang of 
glow irises. If, for example, to declare parametre “the Point About” a "running" index in 
each  glow  iris  from  a  gang  matching  to  parametre,  for  example,  the  Gravity  [1] 
parametre the Point About will "run" all alternatives from 1 to m.
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5.2.3.2.Disposition of alternatives
To fathom modes of a group of alternatives, it is convenient to assume, as if import 
happens under the following circuit design.

1. At first consecutive import of the data matching to unit calculation is executed. 
The  order  of  search  of  alternatives  is  defined  under  the  circuit  design  . 
Formatting of glow irises for each unit  calculation equal also is defined by 
customisations from backfillings Placement  and Template.  We will  assume, 
that from each alternative one glow iris from one curve is put in. Then after that 
pitch for each alternative we will gain page as on , a.

2. Join of the alternatives matching to a modification of the "running" index.

3. Now has come to group a time alternatives.
a.  If it it is not required, the deed will consist of pages of an aspect , a. It 

matches to a mode of group Place every variant into separate page (s) on 
backfilling Variants.

b. If  to  choose  mode  As  a  Table  1D,  all  alternatives  matching  to  a 
modification of the most "sweeping" index (last "not running" parametre 
in the list) at fixed other parametres will be collected on one page (, b). 
For example, for a gang of parametres about  the Island Point will be   
such index

c. At sampling of mode As a Table 2D alternatives will be collected in the 
two-dimensional table. On a vertical the index matching last, on level — 
to penultimate parametre in the list (,) will vary.

For a group of alternatives As a Table 1D and As a Table 2D it is necessary, that in a 
gang there were, at least, one and two usual ("not running") indexes accordingly. 
The group mode is adjusted separately for each gang of parametres (parametre set).

5.3.Edit

5.3.1.Switch Page Format
The command changes a format of current page with book on альбомный and on the 
contrary. Page contents thus are proportionally scaled. A command продублирована in 
the context-sensitive menu, for it accelerator Ctrl+W is provided.
The command is inaccessible to firmware installation.

5.3.2.Cut Copy Paste
Execute excising, copying and an insertion of installations. Patterned installations in the 
program are  pages,  glow  irises  and  separate  curves.  For  copying  of  pages  special 
commands  EditPageCut/Copy  (the  following  point  see)  are  used.  On  an 
insertion of glow irises in the deed of limitations is not present, curves can be put in 
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only in the glow iris, and dimensions of a quantity of axes of glow irises-radiants and 
the receiver should coincide. The glow iris copied from the deed can be put in into the 
application-container as the firmware pd-deed. Paste puts in contents clipboard into the 
deed  irrespective  of,  whether  it  has  been  gained  by  means  of  Cut/Copy or  Page
Cut/Copy. However the insertion mode in these cases is various. In the first case data 
are added to contents of current page, in the second there is a new page and is put in 
before leaking (it truly only for the separate deed: for the firmware deed was possiblly 
only  contents  join).  All  operations  продублированы in  the  context-sensitive  menu 
appearing  by  pressure  of  the  right  button  of  the  mouse  in  a  window.  Buttons  for 
Cut/Copy/Paste also are carried out on a board of instruments ( ).

5.3.3.Clear
Executes  removal  of  the  gated  out  installations  without  copying  in  Clipboard.  Act 
depends on what deed is at the moment active. In the pd-deed was possiblly removal

1. Separate curve.
2. Plotting areas. All curve glow irises in this case are deleted, the glow iris is not 

deleted.
3. Glow irises bodily.
4. The plural  selection  containing  an  arbitrary  combination  enumerated  above 

installations.
At editing of the table of parametre in the design the command deletes a current line. In 
the table cannot be deleted last line with values and a closing empty line.
At editing of a tree of model the command deletes the gated out node. In the present 
version removal only a node of alternative of calculation is is possible. Last remained 
alternative cannot be deleted.
Accelerator — Delete. The button on a board of instruments— .

5.3.4.Page
The submenu is intended for copying, excising and adding of pages. Commands Page
Cut/Copy excise/pattern current page in clipboard which in the subsequent can be put in 
by means of command Paste. Command PageAdd New calls dialogue Add Page for 
adding of new page to the deed. Dialogue allows to adjust parametres of new page and 
its rule in the deed.
Commands of submenu Page продублированы in the context-sensitive menu also are 
inaccessible to the firmware deed.

5.3.5.Properties
The command calls dialogue Properties for the installations gated out at the moment, 
allowing to edit their properties. The dialogue aspect depends on what installations are 
gated out at the moment. If selection contains installations of different types, command 
Properties is inaccessible. A matching accelerator — Ctrl+R.

5.3.6.Embed/Reduce
Calls dialogue Embed/Reduce which is intended for thinning out and embedding of data 
and being, apparently, the instrument for sophisticated users. He allows:

1. To build in the deed the linked data
2. To change density of points/ranges existing given (both linked, and built in).

Overhead  combo  box  dialogue  instal  one  of  the  predetermined  configurations  of 
embedding. It

1. As is. This embedding of data in the deed bodily and without thinning out use. 
On already firmware data this command does not render any act
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2. With  Current  Resolution.  Actually  existing  data  are  substituted  by  the 
sequences used at current drawing. Such mode of a data conversion is useful, if 
the deed is used in the illustrative purposes.

3. With  Custom  Resolution.  The  user  is  submitiven  to  adjust  a  possibility 
separately each of parametres.

It  is  important  to  fathom a variance between thinning out  at  drawing and at  use of 
dialogue Embed/Reduce. In the first case data are not edited, the special sequence for 
their representation to a picture is simply shaped. In the second case editing of data 
occurs.
Command Embed/Reduce is executed for current selection. Thus it is possible to gate 
out separate curves, areas of construction of glow irises and the glow iris bodily. In last 
cases transformation is executed for all curves of the glow iris.
Possible orbs of application 

1. Selection of fragments from the big sequence of data. Having installed With 
Custom  Resolution,  having  disconnected  thinning  out  (flag  Thin  Out)  and 
having set a demanded range it is possible to "excise" a piece of a curve and to 
build in the deed.

2. Creation of masks. As for a mask customisations of representation of a curve, 
instead of data it  is possible to thin out data of a mask with coarse enough 
permission and by that essentially to diminish a file size are important only.

The command is accessible for pd and pdt-deeds both in stand-alone, and in in-place. 
An accelerator — Ctrl+E.

5.3.7.Duplicate Node
Doubles gated out at the moment in Project Bar node of alternative of calculation. At 
invisible Project Bar is absent in the menu. An accelerator — Alt+Insert.

5.3.8.Rename Node
Makes active an editing of a name gated out in Project Bar nodes. In the present version 
renaming only nodes of alternatives of calculations is is possible. Is absent in the menu 
at invisible Project Bar. An accelerator — Ctrl+M.

5.3.9.Reset Content
Rebuilds from the VAR-file linked with the design structure and values of parametres 
gated out in Project Bar nodes. The outcome of act depends on to what node operation is 
applied:

1. Separate changeable parametre (such as the Gravity in item ) or customisations 
решателей Solver Settings. The current table of parametre is substituted on 
that, that is stored in a VAR-file.

2. Node  of  alternative  of  calculation  Variant.  Act  is  equivalent  to  operation 
application to each parametre.

3. Node Volatile Parameters. All nodes of alternatives except one for which name 
Variant is installed are deleted. This node is treated as in the previous point.

4. All design. Nodes Volatile Parameters and Solver Settings are treated, as in the 
previous points, поддерево Results is deleted.

5. Accelerator — Ctrl+D.

5.4.View

5.4.1.Toolbar
Defines, whether the board of instruments is visible at the moment.
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5.4.2.Project Bar
Defines, whether window Project Bar indicating structure of the design opened at the 
moment is visible at the moment. Some points of the menu (EditDuplicate/Rename 
Node, Reset Content) are accessible only at visible Project Bar.

5.4.3.Zoom
Calls  dialogue  Zoom  for  customisation  of  a  scale  of  representation.  Are  possible 
installation of the fixed scale (200, 150, 100, 75, 50 %), by Width, Fit to Window and 
assignment of the user scale. The scale can vary over the range 5-2000 %.

5.4.4. Animate
Rebuilds  a  window  of  visualisation  of  process  of  the  solution.  The  command  is 
accessible only in the course of the solution and at the enclosed window of visualisation. 
An accelerator — Ctrl+A.

5.4.5.Mouse Mode
Commands of  submenu Mouse  Mode instal  a  regime in  which the  mouse is  at  the 
moment used. Version 030928 supports following regimes:

5.4.5.1.Select
Regime of sampling of installations. In this regime selection of installations (as mouse 
click th, and by means of Box Select (only for glow irises)) and drag&drop is carried 
out. Act on double-click: installation selection over which the cursor and a ringing of 
dialogue Properties is. 

5.4.5.2.Box Zoom
Regime of process of scaling. Act on double click: scale reduction to 100 %.

5.4.5.3.SCALE
Glow iris process of scaling. This regime is used for a modification of a range of axes of 
glow irises in style Matlab. Out of glow iris area in regime Scale any acts it  is not 
executed. Act on double-click: out of the glow iris-any of acts, in area of the glow iris-
reduction of ranges of axes in condition Fit to Curves Range.
Submenu Mouse Mode  продублировано in the context-sensitive menu. Regimes also 
can be switched by matching buttons to boards of instruments ( ).

5.4.6.Show Content
Displays the table of values for gated out in Project Bar parametres. The analogous 
effect is attained by pressure Enter the gated out parametre or double by click left button 
of the mouse.

5.4.7.Change Order
The command allows to change a sequence of parametres in a tree of outcomes and by 
that  to  facilitate  process  of  sampling  of  alternatives  of  calculation  demanded  for 
representation. On this command dialogue Parameter Order in which names of gangs of 
parametres at the left are enumerated, and on the right — parametres of the gated out 
gang is called. The order of parametres in this list matches to tree traversal of outcomes 
in a direction from a radical and can be changed by means of buttons and . As a 
result of reorganisation of a tree the condition check box does not vary. The command is 
accessible only if actively window of a tree of design Project Bar and the node from 
поддерева outcomes is gated out. A command продублирована in the context-sensitive 
menu of a window of a tree of the design.
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5.4.8.Run Visualizer
In the presence of the counted outcomes allows to start a player of show animation 3D a 
scene  visualising  behaviour  of  model  at  calculation.  To  become  active,  only  if  in 
поддереве outcomes Project Bar the node of the lower level (represented alternative) 
is gated out left кликом mice, and the focal point is installed on Project Bar.

5.5.Window

5.5.1.Next Page, Prev Page
Instal  in  the  capacity  of  leaking  the  following/previous  page.  These  commands 
продублированы buttons  on  a  board  of  instruments.  Next/Prev  Page  are 
inaccessible to the firmware deed: it always consists of one page.

5.6.Options

5.6.1.Customize
The command calls  dialogue  Customize,  allowing to  adjust  some parametres  of  the 
program. This dialogue is counted for sophisticated users who should work with great 
volumes of data, especially, if they create deeds with references to exterior files of data. 
Now dialogue contains two backfillings

1. Thinning.
Defines, whether it is necessary to use thinning out at representation of curves and if 
follows detailing level allows to define. The there will be values Cell Count less, the 
copying,  but,  probablly,  at  the  expense  of  picture  quality  loss  is  more  sweepingly 
executed. Thinning out can be disconnected generally if to remove flag indicator Enable 
Thinning out. In this case all points of a curve will be drawn. To work always with 
removed flag Enable Thinning Out it is not recommended: at drawing all volume of data 
in this case will  be brought in memory that can lead to an unacceptable velocity of 
operation of the program (and even to hanging).

2. Linked Data.
Customisation defines, what volume of data is patterned on Clipboard if the initial curve 
uses the linked data. 

a. Whole  Sequence.  Together  with the  reference  all  sequence  of  data  is 
patterned. This regime is not recommended to be used by default for the 
same reasons, as in the first point.

b. Currently thinned sequence.  Together  with the reference the sequence 
used at drawing is patterned.

c. Link Only. The reference to a file of data is patterned only.
These customisations are actual only in one case: when the curve with the linked data is 
patterned in  the firmware deed.  The firmware deed cannot  contain references to  an 
exterior file, therefore any data set is necessary to it. If regime Whole Sequence a new 
curve — an exact duplicate initial, with that only a variance, that it stores all data in the 
deed whereas initial  — only the reference is installed.  In regime Currently Thinned 
Sequence the new curve only looks, as initial: really it contains already thinned out data 
set. In the latter case in Clipboard the reference and such curve is patterned only cannot 
be put in, for example, in Word, or in built in in Word deed Pradis32.
It is necessary to note, that these customisations have no value at copying of curves with 
firmware data and a curve insertion in the independent pd-deed: in these cases data are 
patterned, as is, if it is firmware data, all sequence, if linked — only the reference.

3. Animation Background.

27



Customisation of a hum noise of a window of animation. Colour of each angle of a 
window is  separately adjusted.  Colours  are  saved in  a  file  of  customisations of  the 
program and rebuilt at the subsequent starts.

4. # OUTPUT :
Customisation  of  a  leading-out  of  outcomes of  calculation.  To switch on and off  a 
graphic  information  leading-out  it  is  possible  a  daw “Write  PGO file”.  The  switch 
“write every” will allow to choose frequency of a leading-out of the information – on 
each integration  step,  or  on each  N th  pitch.  Flag Write  TBL file  defines,  whether 
outcomes of  calculation in the form of  tables will  be inferred.  At  the installed flag 
except a binary RSL-file for each alternative of calculation there is a text TBL-file with 
the same name.
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6. Control of disposing of glow irises on deed 
page
6.1.As disposing of glow irises on page is defined

The amount and disposition of glow irises on pd-deed page at  import  (for example, 
during a ringing “Show diagrammes”, see pradisui.doc item 6.2.3) is defined by two 
modes:

1. Disposition of glow irises in the mask chosen for import
2. The explicit job of number of glow irises for page

Sampling  of  a  mode  of  distribution  is  carried  out  in  dialogue  Import  Settings  on 
backfilling Template (the description in pradisui.doc subitem 2.4, 2.8, 6.1.4 see, 6.2.3). 
If flag Place As In Template the amount and a disposition of glow irises on page will be 
such what is installed in a mask used for import (a mask in an exactitude is installed can 
be chosen also on backfilling Template). For example, if the mask page looks so:

0 1.08 2.16 3.24 4.32 5.4
 [s]

-5

5
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25

35

45

 [/
]

Variant 
Сила тяжести [1] ; Точка O [2]

 Усилие на опоре по оси Y

0 1.08 2.16 3.24 4.32 5.4
 [s]

-9

-5.4

-1.8

1.8

5.4

9

 [/
]

Variant 
Сила тяжести [1] ; Точка O [2]

 Усилие на опоре по оси X ,
The deed page will contain that two glow irises had similarly.
If flag Place As In Template is removed, or the used mask at all does not contain glow 
irises on page of the created deed of the glow iris place in the form of the table. The 
number of table columns is set in the field Columns, lines — in the field Rows.  For 
example, for creation of the following page:

0 1.08 2.16 3.24 4.32 5.4
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]

Variant 
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 У силие на опоре по оси Y ( Диамет р 1 [1] )
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 Угол пов орота маят ника ( Диаметр 1 [1] )

It is used: Columns = 2, Rows = 3. (Do not forget to remove flag indicator Place as in 
template).
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6.2.Instance: disposing of curves and glow irises on page for 
the test swing

Let the test swing in unique alternative of calculation by default is counted. We will 
mark with a tick node Results in a design tree, and we will call point of the context-
sensitive menu “Show diargrams”.

In the appeared dialogue “Import settings” we will pass to the inset “Template”, and we 
will disconnect a daw “Place as in template”. We will instal amount of rows (Rows) 
glow irises 2, and amount of columns – 3.

Now we will pass to the inset “Placement”. We will instal the filter for the curves which 
are represented in a window “Input channels” (the falling out list “Show channels”) in 
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value “Unused”. Then we will delete all existing glow irises, gating out the glow iris in 
the list “Existing diagrammes”, and pushing the button “the marksman to the right”, to 
the right of this list.

Further  we will  create  the new,  empty glow iris,  having pushed on the button “the 
marksman to the left”, to the right of the list “Existing diagrammes”.

Now we will gate out by means of left a mouse clique at pushed “Ctrl”, curves 1 and 5 
of the list “Input channels”.
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Then  we  will  push  the  button  “the  marksman  downwards”,  over  the  list  “Active 
diagramme”. Curves will be displaced to this list that means, that in the glow iris created 
by us these two curves will hit.

Further we will create 6 more new glow irises, pushing the button on the button “the 
marksman to the left”, to the right of the list “Existing diagrammes”. In each of them we 
will put on one curve from the list “Input channels”, gating out at first number of the 
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first empty glow iris in the list “Existing diagrammes”, then gating out first one after 
another  a  curve  in  “Input  channels”,  and  pushing  the  button  “the  marksman 
downwards”, over the list “Active diagramme”. Thus, we will generate the list from 7 
glow irises, and the list of not used input curves becomes empty.

After that it is possible to change an order of glow irises in the list, gating out the glow 
iris with certain number and displacing it in the list buttons “the marksman up” and an 
arrow downwards under the list “Existing diagrammes”. Now we will push on OK in 
dialogue “Import settings”. The deed pd will be created.

As we see, on the first page there were the first six glow irises which have been had in 
the two-dimensional table, according to the sizes of the table chosen in the contribution 
“Template” of dialogue “Import settings”. On the second page last, seventh glow iris 
has hitted.
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The chosen strategy of disposing of curves under glow irises and glow irises on page 
can be saved to apply then at test calculations swing. For this purpose

1. Not enclosing the deed pd (page with graphs in the previous drawing), we will 
create a new mask, having called the menu File-> New, having installed in 
dialogue “New document” type Pradis32 Template, then having pushed OK in 
dialogue “New document”.

2. To appear empty page with a mask. We will save the created mask, having 
called the menu File-> Save and having assigned a file name swing.

3. Let's enclose the created mask, having called the menu File-> Close.
4. Now again there is active a page with graphs. We will load our new mask for it, 

having called the menu File-> Change Template, and having opened the file 
created earlier swing.

5. Now we will save the strategy of disposing of glow irises on page of graphs in 
a mask swing, having chosen the menu File-> Overwrite template.

6. Let's enclose page with graphs through the menu File-> Close.
7. Anew  we  will  call  the  context-sensitive  menu  “Show  diagrammes”  for 

scanning of outcomes.
8. In  the appeared dialogue “Import settings” in  the inset  “Template” we will 

instal a daw “Place as in template”. It is necessary to be convinced, that the 
mask swing in the field “Use template” is installed.

9. After pressure OK in dialogue “Import settings” on page with glow iris graphs 
will be placed on 6 on page in tables.

10. Let's note, that in a mask (template) the strategy of disposing of glow irises on 
page,  but  not  curves  under  glow  irises  is  saved  only.  If  to  interchange 
distribution of curves under glow irises in the inset “Placement”, other glow 
irises will already take places on page according to a mask.

11. “Import settings” (disposing of curves under glow irises, a mask name, etc.) it 
is  possible  to  save  and load  all  customisations  of  dialogue  into  the  import 
scenario (a file sci) by buttons Load/Save. For example, once correctly having 
adjusted disposing of curves under glow irises and a mask name in dialogue 
“Import settings”, we save these customisations, having pushed on “Save”, and 
having chosen a file swing.sci.

12. Now it is possible to enclose the program, anew to open the design swing, to 
count it. Then to call scanning of outcomes (“Show diagrammes”) and to load 
by button "Load" into dialogue “Import settings” customisations from a file 
swing.sci.

13. After pressure on OK in dialogue “Import settings” the page with graphs will 
look in  an  exactitude,  as  in  the  previous  drawing.  Will  be  rebuilt  also  the 
strategy  of  disposing  of  curves  under  glow  irises,  and  the  strategy  of  a 
disposition of glow irises on page.
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